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1.  Installation of AGISoft Professional Plus software 

1.1. System requirements 

1.1.1. Minimal configuration 

• Windows XP or later (32 or 64 bit), Mac OS X Snow Leopard or later, Debian/Ubuntu (64 

bit) 

• Intel Core 2 Duo processor or equivalent 

• 2GB of RAM 

 

1.1.2. Recommended configuration 

• Windows XP or later (64 bit), Mac OS X Snow Leopard or later, Debian/Ubuntu (64 bit) 

• Intel Core i7 processor 

• 12GB of RAM 

The number of photos that can be processed by PhotoScan depends on the available RAM and 

reconstruction parameters used. Assuming that a single photo resolution is of the order of 10 

MPix, 2GB RAM is sufficient to make a model based on 20 to 30 photos. 12GB RAM will 

allow to process up to 200-300 photographs. The more the RAM will be the more photos it can 

process. 

 

1.2. Preferences settings 
Before starting a project with PhotoScan it is recommended to adjust the program settings for 

your needs. In Preferences dialog (General Tab) available through the Tools menu you can 

indicate the path to the PhotoScan log file to be shared with the Agisoft support team in case 

you face any problem during the processing. Here you can also change GUI language to the 

one that is most convenient for you. The options are: English, Chinese, French, German, 

Japanese, Portuguese, Russian, Spanish. 

On the OpenCL Tab you need to make sure that all OpenCL devices detected by the program 

are checked. PhotoScan exploits GPU processing power that speeds up the process 

significantly. If you have decided to switch on GPUs for photogrammetric data processing with 

PhotoScan, it is recommended to free one physical CPU core per each active GPU for overall 

control and resource managing tasks. 
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Figure: Preference setting 
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2. General workflow 
Processing of images with PhotoScan includes the following main steps: 

1. Loading photos into PhotoScan; 

2. Making GeoTIFF for SlantRange image; 

3. Inspecting loaded images, removing unnecessary images; 

4. Aligning photos; 

5. Building dense point cloud; 

6. Building mesh (3D polygonal model); 

7. Generating texture 

8. Building tiled model 

9. Building digital elevation model; 

10. Building orthomosaic; 

11. Exporting results. 

We don’t use generating texture and building tiled model. We use digital elevation model at 

the time of Digital Surface Model (DSM) preparation and export the DSM in tif format. 
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3. Opening AGISoft 
To open the AGISoft, double click on (AGISoft PhotoScan Icon) 

  

 

 

3.1. Loading photos 
Before starting any operation, it is necessary to point out what photos will be used as a source 

for 3D reconstruction. In fact, photographs themselves are not loaded into PhotoScan until they 

are needed. So, when you "load photos" you only indicate photographs that will be used for 

further processing. 

To load a set of photos 

1. Select Add Photos... command from the Workflow menu or click Add Photos toolbar 

button on the Workspace pane. 

2. In the Add Photos dialog box browse to the folder containing the images and select files to 

be processed. Then click Open button. 

3. Selected photos will appear on the Workspace pane. 

Note: PhotoScan accepts the following image formats: JPEG, TIFF, PNG, BMP, PPM, 

OpenEXR and JPEG Multi-Picture Format (MPO). Photos in any other format will not be 
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shown in the Add Photos dialog box. To work with such photos, you will need to convert them 

in one of the supported formats. 

 

4. GeoTIFF Preparation in SlantView Software 
 To open the SlantView software double click on (SlantView icon)  

 

 

 

 

 

 

 

 

 

 

 

 To select the desired dataset just click on data and select processed dataset 
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 Then go to folder to select the desired dataset for making GeoTIFF file. That GeoTIFF 

file will be readable in AGISoft. 

 

 

 After selecting the dataset, it will show the full name of the folder. Select Grower that 

will indicate the name of organization like CIMMYT. Select field name (ex: Dinajpur) 

and crop types (ex: Maize, Wheat etc.). Go to process and select Export images. Then it 

will show you an interface like below image: 
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 Check Convert pixel values to reflectance and Trim images to valid content.  
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 Click ok and then it will show you the following interface: 

 

 

 

 

 

 

 

 

 

 

 

 

 When the process will be done then a folder named GeoTIFF will created into the 

selected folder. These GeoTIFF images have to be used for mosaic in AGISoft. 
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5. Loading RGB and SlantRange Photos 

5.1. Loading RGB Photos 
Select Add Photos... command from the Workflow menu or click Add Photos toolbar button 

on the Workspace pane. 

 

In the Add Photos dialog box browse to the folder containing the images and select files to be 

processed. Then click Open button. 
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Selected photos will appear on the Workspace pane.  

 

 

 

 

 

 

 

 

 

 

Note: PhotoScan accepts the following image formats: JPEG, TIFF, PNG, BMP, PPM, 

OpenEXR and JPEG Multi-Picture Format (MPO). Photos in any other format will not be 

shown in the Add Photos dialog box. To work with such photos, you will need to convert 

them in one of the supported formats. 

If you have loaded some unwanted photos, you can easily remove them at any moment. 

 

5.1.1. Remove unwanted photos 

1. On the Workspace pane select the photos to be removed. 

2. Right-click on the selected photos and choose Remove Items command from the opened 

context menu, or click Remove Items toolbar button on the Workspace pane. The selected 

photos will be removed from the working set. 

 

5.2. Multispectral imagery 
PhotoScan supports processing of multispectral images saved as multichannel (single page) 

TIFF files. The main processing stages for multispectral images are performed based on the 

master channel, which can be selected by the user. During orthophoto export, all spectral bands 

are processed together to form a multispectral orthophoto with the same bands as in source 

images. 

The overall procedure for multispectral imagery processing does not differ from the usual 

procedure for normal photos, except the additional master channel selection step performed 

after adding images to the project. For the best results it is recommended to select the spectral 

band which is sharp and as much detailed as possible. 
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5.2.1. Create a chunk from multilayer images 

1.Select Add Photos... command from the Workflow menu or click Add Photos toolbar button. 

2. In the Add Photos dialog box browse to the folder containing multilayer images and select 

files to be processed. Then click Open button. 

3. In the Add Photos dialog select the data layout "Create multispectral cameras from files as 

cameras". 

4. Created chunk with multispectral cameras will appear on the Workspace pane. 

 

 

5.2.2. Select master/Primary channel 

Add multispectral images to the project using Add Photos... command from the Workflow 

menu or Add Photos toolbar button 
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Select Set Master Channel... command from the chunk context menu in the Workspace pane.

 

In the Set Master Channel dialog select the channel (Usually Channel 4) to be used as master 

and click OK button. Display of images in PhotoScan window will be updated according to the 

master channel selection. 
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Note: Set Master Channel... command is available for RGB images as well. You can either 

indicate only one channel to be used as the basis for photogrammetric processing or leave the 

parameter value as Default for all three channels to be used in processing. 

 

6. Saving intermediate results 
Certain stages of 3D model reconstruction can take a long time. The full chain of operations 

could eventually last for 4-6 hours when building a model from hundreds of photos. It is not 

always possible to complete all the operations in one run. PhotoScan allows to save 

intermediate results in a project file. PhotoScan Archive files (*.psz) may contain the following 

information: 

 List of loaded photographs with reference paths to the image files. 

 Photo alignment data such as information on camera positions, sparse point cloud model 

and set of refined camera calibration parameters for each calibration group. 
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7. Aligning photos 

7.1. Align Photos 

Once photos are loaded into PhotoScan, they need to be aligned. At this stage PhotoScan finds 

the camera position and orientation for each photo and builds a sparse point cloud model. 

To align a set of photos 

 Select Align Photos... command from the Workflow menu. 

 In the Align Photos dialog box select the desired alignment options. Click OK button 

when done. 

 The progress dialog box will appear displaying the current processing status. To cancel 

processing click Cancel button. 
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 Alignment having been completed, computed camera positions and a sparse point cloud 

will be displayed. You can inspect alignment results and remove incorrectly positioned 

photos, if any. To see the matches between any two photos, use View Matches... 

command from a photo context menu in the Photos pane. Incorrectly positioned photos 

can be realigned. 

 

 

7.2. Delete unexpected pixels by using rectangle selection tool 
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7.3. Realign a subset of photos 

 Reset alignment for incorrectly positioned cameras using Reset Camera Alignment 

command from the photo context menu. 

 Set markers (at least 4 per photo) on these photos and indicate their projections on at 

least two photos from the already aligned subset. PhotoScan will consider these points 

to be true matches.  

 Select photos to be realigned and use Align Selected Cameras command from the 

photo context menu. 

 The progress dialog box will appear displaying the current processing status. To 

cancel processing click Cancel button. 

When the alignment step is completed, the point cloud and estimated camera positions can be 

exported for processing with another software if needed. 

 

7.4. Alignment parameters 
The following parameters control the photo alignment procedure and can be modified in the 

Align Photos dialog box: 

7.4.1. Accuracy 

Higher accuracy settings help to obtain more accurate camera position estimates. Lower 

accuracy settings can be used to get the rough camera positions in a shorter period of time. 

While at High accuracy setting the software works with the photos of the original size, Medium 

setting causes image downscaling by factor of 4 (2 times by each side), at Low accuracy source 

files are downscaled by factor of 16, and Lowest value means further downscaling by 4 times 

more. Highest accuracy setting upscales the image by factor of 4. Since tie point positions are 

estimated on the basis of feature spots found on the source images, it may be meaningful to 

upscale a source photo to accurately localize a tie point. However, Highest accuracy setting is 

recommended only for very sharp image data and mostly for research purposes due to the 

corresponding processing being quite time consuming. 

 

8. Setting Coordinate system and import the coordinate text file 

8.1. Setting Coordinate syatem 

Many applications require data with a defined coordinate system. Setting the coordinate system 

also provides a correct scaling of the model allowing for surface area and volume 

measurements and makes model loading in geoviewers and geoinformation software much 

easier. Some functionality like digital elevation model export is available only after the 

coordinate system is defined. 
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PhotoScan supports setting a coordinate system based on either ground control point (marker) 

coordinates or camera coordinates. In both cases the coordinates are specified in the Reference 

pane and can be either loaded from the external file or typed in manually. 

Setting coordinate system based on recorded camera positions is often used in aerial 

photography processing. However, it may be also useful for processing photos captured with 

GPS enabled cameras. Placing markers is not required if recorded camera coordinates are used 

to initialize the coordinate system. 

In the case when ground control points are used to set up the coordinate system the markers 

should be placed in the corresponding locations of the scene. 

Using camera positioning data for georeferencing the model is faster since manual marker 

placement is not required. On the other hand, ground control point coordinates are usually more 

accurate than telemetry data, allowing for more precise georeferencing. 

 

8.2. Placing markers 
PhotoScan uses markers to specify locations within the scene. Markers are used for setting up 

a coordinate system, photo alignment optimization, measuring distances and volumes within 

the scene as well as for marker based chunk alignment. Marker positions are defined by their 

projections on the source photos. The more photos are used to specify marker position the 

higher is accuracy of marker placement. To define marker location within a scene it should be 

placed on at least 2 photos. 

To place a marker using guided approach 

 Open a photo where the marker is visible by double clicking on its name. 

 Switch to the marker editing mode using Edit Markers toolbar button. 

 Right click on the photo at the point corresponding to the marker location. 

 Select Place Marker command from the context menu. Marker list will be visible there 

and desired marker have to select. 

 Rename the markers according to the GCP text file format. 

 All the markers have to be placed. 
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To save up time on manual marker placement procedure PhotoScan offers guiding lines feature. 

When a marker is placed on an aligned photo, PhotoScan highlights lines, which the marker is 

expected to lie on, on the rest of the aligned photos. 

 

8.3.  Load reference coordinates from a text file 
Click Import toolbar button on the Reference pane. (To open Reference pane use Reference 

command from the View menu.) 

 

Fig: Unplaced Marker Fig: Placed Marker 
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 Browse to the file containing recorded reference coordinates and click Open button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 In the Import text/CSV dialog set the coordinate system if the data presents 

geographical coordinates. 

 

 Select the delimiter and indicate the number of the data column for each coordinate. 

Indicate columns for the orientation data if present. 

 Click OK button. The reference coordinates data will be loaded onto the Reference 

pane. 
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9. Building dense point cloud 

9.1. Dense point cloud 

PhotoScan allows to generate and visualize a dense point cloud model. Based on the estimated 

camera positions the program calculates depth information for each camera to be combined 

into a single dense point cloud. PhotoScan tends to produce extra dense point clouds, which 

are of almost the same density, if not denser, as LIDAR point clouds. A dense point cloud can 

be edited and classified within PhotoScan environment or exported to an external tool for 

further analysis. 

To build a dense point cloud 

1. Check the reconstruction volume bounding box. To adjust the bounding box, use the 

Resize Region and Rotate Region toolbar buttons. Rotate the bounding box and then drag 

corners of the box to the desired positions. 

2. Select the Build Dense Cloud... command from the Workflow menu. 

3. In the Build Dense Cloud dialog box select the desired reconstruction parameters. Click 

OK button when done. 
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4. The progress dialog box will appear displaying the current processing status. To cancel 

processing click Cancel button. 

 

 

9.2. Reconstruction parameters 

9.2.1. Quality 

Specifies the desired reconstruction quality. Higher quality settings can be used to obtain more 

detailed and accurate geometry, but they require longer time for processing. Interpretation of 

the quality parameters here is similar to that of accuracy settings given in Photo Alignment 

section. The only difference is that in this case Ultra High quality setting means processing of 

original photos. 

 

10.  Building mesh 

10.1. Building mesh 

1. Check the reconstruction volume bounding box. If the model has already been referenced, 

the bounding box will be properly positioned automatically. Otherwise, it is important to 

control its position manually. 



UAV/Drone Image Processing Manual  

25 | P a g e  

 

To adjust the bounding box manually, use the Resize Region and Rotate Region toolbar 

buttons. Rotate the bounding box and then drag corners of the box to the desired positions - 

only part of the scene inside the bounding box will be reconstructed. If the Height field 

reconstruction method is to be applied, it is important to control the position of the red side of 

the bounding box: it defines reconstruction plane. In this case make sure that the bounding box 

is correctly oriented. 

2. Select the Build Mesh... command from the Workflow menu. 

3. In the Build Mesh dialog box select the desired reconstruction parameters. Click OK button 

when done. 

4. The progress dialog box will appear displaying the current processing status. To cancel 

processing click Cancel button. 

 

 

10.2. Reconstruction parameters 
PhotoScan supports several reconstruction methods and settings, which help to produce 

optimal reconstructions for a given data set. 

10.2.1. Surface type 

Arbitrary surface type can be used for modeling of any kind of object. It should be selected 

for closed objects, such as statues, buildings, etc. It doesn't make any assumptions on the type 

of the object being modeled, which comes at a cost of higher memory consumption. 

Height field surface type is optimized for modeling of planar surfaces, such as terrains or 

basereliefs. It should be selected for aerial photography processing as it requires lower amount 

of memory and allows for larger data sets processing. 

10.2.2. Source data 

Specifies the source for the mesh generation procedure. Sparse cloud can be used for fast 3D 

model generation based solely on the sparse point cloud. Dense cloud setting will result in 
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longer processing time but will generate high quality output based on the previously 

reconstructed dense point cloud. 

11.  Building orthomosaic 
Orthomosaic export is normally used for generation of high resolution imagery based on the 

source photos and reconstructed model. The most common application is aerial photographic 

survey data processing, but it may be also useful when a detailed view of the object is required. 

PhotoScan enables to perform orthomosaic seamline editing for better visual results. 

To build Orthomosaic 

1. Select the Build Orthomosaic... command from the Workflow menu. 
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2. In the Build Orthomosaic dialog box set Coordinate system for the Orthomosaic 

referencing. 

 

3. Select type of surface data for orthorectified imagery to be projected onto. 

4. Click OK button when done. 

5. The progress dialog box will appear displaying the current processing status. To cancel 

processing click Cancel button. 

12. Building digital elevation model 
PhotoScan allows to generate and visualize a digital elevation model (DEM). A DEM 

represents a surface model as a regular grid of height values. DEM can be rasterized from a 

dense point cloud, a sparse point cloud or a mesh. Most accurate results are calculated based 

on dense point cloud data. PhotoScan enables to perform DEM-based point, distance, area, 
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volume measurements as well as generate cross-sections for a part of the scene selected by the 

user. Additionally, contour lines can be calculated for the model and depicted either over DEM 

or Orthomosaic in Ortho view within PhotoScan environment. 

To build DEM 

1. Select the Build DEM... command from the Workflow menu. 

 

2. In the Build DEM dialog box set Coordinate system for the DEM. 
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3. Select source data for DEM rasterization. 

4. Click OK button when done. 

5. The progress dialog box will appear displaying the current processing status. To cancel 

processing click Cancel button. 

 

12.1. Exporting results for DEM 
PhotoScan supports export of processing results in various representations: sparse and dense 

point clouds, camera calibration and camera orientation data, mesh, etc. Orthomosaics and 

digital elevation models (both DSM and DTM), as well as tiled models can be generated 

according to the user requirements. Point cloud and camera calibration data can be exported 

right after photo alignment is completed. All other export options are available after the 

corresponding processing step. 

If you are going to export the results (point cloud / mesh / tiled model / orthomosaics) for the 

model that is not referenced, please note that the resulting file will be oriented according to a 

default coordinate system you see in PhotoScan window. To align the model orientation with 

the default coordinate system, use Rotate object button from the Toolbar. 

Point cloud export from DEM 

To export sparse or dense point cloud 

1. Select Export Points... command from the File menu. 
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2. Browse the destination folder, choose the file type, and print in the file name. Click Save 

button. 

3. In the Export Points dialog box select desired Type of point cloud - Sparse or Dense. 

4. Specify the coordinate system and indicate export parameters applicable to the selected file 

type, including the dense cloud classes to be saved. 

 

5. Click OK button to start export. 

6. The progress dialog box will appear displaying the current processing status. To cancel 

processing click Cancel button. 
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12.2. Opening output tiff. mosaic DEM file in ArcGIS for further analysis 
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13. Point cloud export from Orthomosaic photo 
To export sparse or dense point cloud 

1. Select Export Points... command from the File menu. 

 

2. Browse the destination folder, choose the file type, and print in the file name. Click Save 

button. 

3. In the Export Points dialog box select desired Type of point cloud - Sparse or Dense. 
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4. Specify the coordinate system and indicate export parameters applicable to the selected file 

type, including the dense cloud classes to be saved. 

5. Click OK button to start export. 

6. The progress dialog box will appear displaying the current processing status. To cancel 

processing click Cancel button. 

 

13.1. Opening output tiff. mosaic file in ArcGIS for further analysis 
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14. Transferring and Opening a processed AGISoft project 
 Double click on the transferred AGISoft file and then it will open. 

 Go to Photos option just beside the Workspace option. 

 Select one photo from the loaded photos and right click of your mouse. 

 

 

 Select and click on Change Path then it will show you an option. 

 

 
 

 

 Check and click on All cameras and click on Ok. 

 It will then have asked you to select the desired photo (you right click on the photo) 

from the Raw data captured by drone. 
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 Then click open. 

 

 

 

15. Versions of Software and download link 
 Agisoft Photoscan Professional Plus: 

 Version: photoscan-pro_1_4_3_x64 

 URL:  https://www.agisoft.com/downloads/installer/  

 

 SlantView 

Version: slantview_setup.2.6.131 

URL: https://analytics.slantrange.com/Download/SlantViewIndex  

https://www.agisoft.com/downloads/installer/
https://analytics.slantrange.com/Download/SlantViewIndex

